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1.1 Overview

1.1.1 Introduction to the Manual

The following chapters provide a complete description of the EMI Application Software ES-K1. Users
working with the EMI Apllication Software ES-K1 for the first time are recommended to read through
chapters 1 to 4 one after the other.

Chapter 1 "Introduction", provides a general overview.

Chapter 2 "Graphical User Interface“, describes the elements of the graphical user interface.

Chapter 3 "Standard Script Description", provides information on the enclosed standard scripts.

Chapter 4 "Standard Device Drivers", describes the function of the Rohde & Schwarz V-networks,
relay switching units, etc..

The Options ES-Kxx provide information about the use of the script language FSL (Flexible Script
Language) and the device drivers.

Option ES-K2, "Script Development Kit", explains how a script is produced and includes a
description of the general language elements of FSL and a list of all standard
functions, system-specific and device-specific functions.

Option ES-K1x, "Device Driver", contains a list of all device drivers for test receivers and spectrum
analyzers including their application, which are supported by the EMI Application
Software ES-K1.

Option ES-K3x, "Device Driver", contains a list of all device drivers for accessories including their
application, which are supported by the EMI Application Software ES-K1.

Option ES-K50, "Device Driver", contains the universal IEEE-bus device driver for simple ASCII
communication with devices that can be controlled via IEEE bus.

Option ES-K80, "Device driver", contains the device driver for the R&S TTL card PS-B11.
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1.1.2 Short Description

The Rohde&Schwarz EMI Software package ES-K1 is an up-to-date and user-friendly software which
can be ideally used for all EMI measurements of conducted and radiated interference.

The number of measurements required to ensure electromagnetic compatibility (EMV) is continuously
increasing, along with the demand for reliability, reproducibility and economic efficiency of these
measurements.

Features of the EMI Application Software ES-K1:

ü User-friendly software for Microsoft WindowsTM 95 / 98 / 98SE / ME / NT 4.0 / 2000 / XP

ü EMI measurements both to international commercial standards (CISPR, VDE, FCC, VCCI,
ANSI, EN) and military standards (MIL, VG, DEF-STAN, GAM-EG13)

ü Possible adaptation to other standards

ü Automatic and interactive mode

ü Transmission factors and limit lines are automatically considered in the calculation of the results

ü Evaluation of narrowband and broadband interference

ü Calibration of the test setup

ü Comfortable and flexible documentation of measurement results

ü Various ways of data export

ü Future extensions can be easily implemented due to the option concept

1.1.2.1 Graphical User Interface

The EMI Application Software ES-K1 for WINDOWSTM is equipped with a graphical user interface,
which permits to start with the program immediately and can be readily operated by the user.

1.1.2.2 Operating Modes of the Software

The measurement procedures can be executed either in interactive mode or automatically, depending
on the application of the software.

a) Interactive mode
In interactive mode, each device can be controlled individually by means of its own window. All other
functions such as measuring and analyzing functions can also be operated interactively.

b) Automatic mode
The automatic measurement runs are implemented by scripts of a macro language, thus releasing the
user from routine tasks. The scripts control the measurement run, evaluate the measurement results
and produce the necessary reports for documentation of the measurement results.

An option for the system software is the Script Development Environment (ES-K2). This environment
permits the user to modify the supplied standard scripts in order to match them to the latest standards. It
also allows him to develop scripts that cover completely new standards. Of course, this environment
also contains debugging aids and test facilities, which simplify the generation and modification of the
scripts.
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1.1.2.3 Measuring and Analyzing Functions

The Software ES-K1 supports a number of measuring and analyzing functions. This is necessary to
minimize the number of measurements to be performed again, which are very time-consuming.

Possible measurements are the scan, the execution of a fast overview measurement (sweep) and the
measurement performed at discrete frequencies.

The most important ways of evaluation (data reduction) are the acceptance analysis, peak reduction,
subrange maxima and subrange minima reduction, maxima reduction and narrowband/broadband
discrimination.

Further possible evaluations are used to combine measurement results, output MIL measurement
results in a broadband-related display (/MHz) and eliminate known interference, e.g. ambients.

A very particular type of data handling is the GTEM correlation, which permits to convert measurement
results to open-area conditions using the GTEM cell.
A similar correlation for S-LINE measurement cells is also available.

1.1.2.4 Graphics and Report

Measurement results, limit lines and transducer factors can be displayed in a manifold and flexible way
as table or graphics. Up to eight different traces can be shown in a window with linear or logarithmic
frequency axis. The shape, line style and colour of the graphical elements can be optimally adapted to
the requirements of the documentation.

For interactive, graphical evaluation of the measurement results, a marker and a delta marker are
available, which can be easily positioned using the mouse. The zoom function permits to enlarge any
section of the measurement. The measurement results can be displayed simultaneously in various
windows.

The measurement results are summed up in a report which is configured by the user himself. In addition
to a report header, all data relevant to the measurement can be output, e.g. scan and sweep table. The
output of the measurement results, limit lines and transducers is possible both in tabular and graphical
form.

1.1.3 Licence

The EMI Application Software ES-K1 is protected by a hardware adapter (hardlock), which is connected
to the parallel interface of the computer. This does not impair the function of the interface, i.e. the
adapter is transparent for the user.

Note:

The user must make sure that the hardlock is firmly connected!
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1.2 Installation

1.2.1 System Requirements

EMI Application Software ES-K1 can be used with any computer fulfilling the following system
requirements:

• Microsoft WindowsTM 95 / 98 / 98SE / ME / NT 4.0 / 2000 / XP

• CPU: 486; PENTIUM recommended

• 16 Mbyte RAM; 64 Mbytes recommended

• At least 60 Mbytes free memory on the harddisk

• SVGA graphics adapter (800x600 pixels); XVGA (1024x768 pixels) recommended

• GPIB interface compatible with National Instruments GPIB interface with Windows device driver
(PCII/IIA, AT-GPIB , AT-GPIB/TNT, PCI-GPIB, PCMCIA-GPIB)

EMI Software ES-K1 fitted with the associated drivers for GPIB interface can be used with the operating
systems listed above.

The installation software automatically considers the conditions depending on the operating system.

Note: All path indications generated in the ES-K1 have to comply with DOS conventions, i.e.
meet the rule  <8 characters>.<3 extension>  .

1.2.2 Options Concept

Due to its options concept the software is easy to handle and future-safe. The drivers required for the
units and additional software options  are combined to form the software core.

EMI Software ES-K1 supports all EMI test receivers and spectrum analyzers from Rohde & Schwarz, ie
the models of receiver family ESCS, ESHS, ESVS, ESVD, ESPC und ESS, the EMI test receivers
based on spectrum analyzers ESPI, ESIB, ESAI, ESBI und ESMI and still the instruments ESH3, ESVP
and EZM.
In addition to these receivers, a large number of remote-controllable accessories is used. These are
amongst others artificial-mains networks and V-networks ESH2-Z5, ENV4200, ESH3-Z5 and ENV216,
Absorbing Clamp Slideways for the measurement of conducting interference as well as remote-
controllable Positioning Mast and Turntable for measuring RFI fieldstrength. Relay matrices are used for
switching the antenna and transducers.
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1.2.2.1 Basic Program

EMI Software ES-K1 comprise the following components:

• EMI software core under WindowsTM contains the graphics user interface, standard scripts for
automated test sequences and  other standard data (limit values, etc.)

• Drivers for R&S artificial-mains networks ESH2-Z5, ENV4200, ESH3-Z5 and ENV216 as well as for
R&S relay switch units (PSU, RSU,PSN, TS-RSP).

• Internal database for data management (scripts, limit-value lines, transducers, graphics, scan tables,
test results, etc.)

The data of ES-K1 internal database can be exported for transfer and filing operations, new data can be
imported.
The internal database can be configured with the supplied standard data during the installation.

1.2.2.2 Options

The following options (receiver and accessories) can be used with ES-K1:

ES-K2 Script development environment

ES-K10 Driver for R&S EMI test receivers ESCS / ESPC / ESHS / ESVS / ESVD
ES-K11 Driver for R&S EMI test receivers ESS
ES-K12 Driver for R&S EMI test receivers ESAI / ESBI / ESMI
ES-K13 Driver for R&S EMI test receivers ESH3 / ESVP
ES-K14 Driver for R&S EMI test receivers ESH3-EZM / ESVP-EZM
ES-K15 Driver for R&S spectrum analyzers FSA / FSB / FSM
ES-K16 Driver for R&S EMI test receivers ESIB and spectrum analyzers FSE (FSIQ)
ES-K17 Driver for R&S tempest receivers FSET
ES-K18 Driver for R&S EMI test receivers ESPI
ES-K19 Driver for R&S spectrum analyzers FSP and FSU
ES-K20 Driver for R&S EMI test receivers ESCI

ES-K30 Driver for Schäfer Mast HCM (RSM) and Turntable HCT (RST)
ES-K31 Driver for Schäfer Absorbing Clamp Slidebar HCA (RSA)
ES-K32 Driver for EMCO Mast with Controller 1050 and EMCO Turntable with Controller 1060, as

well as for combined Controllers 1090 and 2090
ES-K33 Driver for DEISEL Mast and Turntable with Controller HD50/100
ES-K34 Driver for DEISEL Absorbing Clamp Slidebar with Controller HD50/100
ES-K37 Driver for AKZO Mast and Turntable with Controller ASC-300
ES-K40 Driver for EMCO Mast and Turntable with Controller 2090, and for SUNOL Mast and

Turntable with Controller SC9xV

ES-K50 Universal GPIB driver

1.2.2.3 Multiple-user Licences

ES-K100 Licence for the use of EMI Application Software by several users. An additional hardlock
will be supplied for each ES-K100 ordered.

1.2.3 Installation Instructions

Scope of supply of EMI Software ES-K1:

• CD-ROM for installing the software
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• Hardlock key (dongle) for authentication (not with an update)

• Option disk with customer-specific authentication code (not with an update)

• Operating manual (not with an update)

The EMI Software ES-K1 is installed on the PC from the the CD-ROM.
If necessary then a set of installation disks can be generated from the CD-ROM through starting the
batch file 'DISKS.BAT'. Eight formatted disks will be needed then.

1.2.3.1 Manuals on the CD-ROM

On the CD-ROM there's a subdirectory 'Manuals' which holds PDF files that represent the manuals.
Those files can be viewed and printed with the "Acrobat Reader" from Adobe Systems Inc. It also
enables to perform full text searches.
The "Acrobat Reader" is an application which is available free of charge (freeware) and also included on
the CD-ROM. If that application is already installed on the PC then PDF files can be viewed without
further action. In the Internet there are many documents stored as PDF files. The latest version of the
"Acrobat Reader" can also be downloaded from the Internet (http://www.adobe.com).
To install the "Acrobat Reader" (version 4.0) from the CD-ROM on your computer proceed as follows
(drive D: refers to the CD-ROM drive):

Go to the "Start" button and select "Run".
Enter  ' D:\AcroRd32\setup '  and follow the instructions of the installation program.

1.2.3.2 ES-K1 on the Controller Function of the EMI Analyzer ESIB

If the application ES-K1 shall be installed on the controller function (Windows NT) of the EMI analyzer
ESIB then the following topics have to be considered:
The built-in LCD display has a resolution of 640x480 pixels (VGA), but the application requires a
resolution of minimum 800x600 pixels (SVGA). Therefore the application can only be operated with an
external monitor for which a higher resolution can be selected. To do so the softkey "Ext. Monitor" in the
general setup of the instrument firmware has to be activated and then on the PC side (Windows NT) the
property settings of the 'Display' ('Control Panel') have to be modified. Further details can be found in
the ESIB manual (chapter 1.7: Connecting an External Monitor).
For the installation of the application under Windows NT you need administrator access privileges
because also the hardlock driver (a system driver) needs to be installed. You have to do a login with the
'administrator' identification. Further details can be found in the ESIB manual (chapter 1.4: Controller
Function). Once the application has been successfully installed you can change back to the original
login with 'instrument' identification.
If the application doesn't need to control any other GPIB devices besides the ESIB then a second GPIB
interface is not necessary and can be replaced by the internal software interface "RSIB". Further details
can be found in the ES-K16 manual (Operation with the RSIB Interface)

1.2.3.3 Authentication

When using ES-K1 software, the hardlock key (dongle) is required for authentication if a test receiver
and/or accessories are to be controlled via the GPIB interface. If the software is operated without a
suitable hardlock, it runs in the im Demo mode, i.e. the GPIB interface cannot be physically addressed,
the units can only be operated virtually. The other functions can all be used without any restriction.

The hardlock is not required during installation but on starting the ES-K1.
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1.2.3.4 Option Disk

This disk which is supplied in addition to the installation disk and queried by the software during
installation contains the ID files (ID: identification) coded to the associated hardlock key according to the
specific customer's requirements. The files allow the use of ES-K1 with the user's test receivers or
options (accessories). The options are offered by the setup program for installation.
If no option disk is available then only an update can be done which in turn requires the existence of an
earlier installation or version of the application.
If an installation of version 1.50 exists then an option disk can b egenerated from there through starting
the batch file 'OPT-DISK.BAT' in the referring subdirectory '...\EXECUTE\'.

1.2.3.5 Preparation for Installation

Prior to installation, check the GPIB configuration for correct settings (using the configuration program
supplied with the GPIB card):

DMA Channel: NONE, driver setting and interface setting should match
Base I/O Address: driver setting and interface setting should match
Interrupt Line: driver setting and interface setting should match; may alsobe

set to NONE
Enable Auto Serial Polling: NO
Assert REN when System Controller YES

All settings can be performed indepedent of the operating system using the associated configuration
programs. The configuration can to be set in the 'Control Panel' under 'System' using the 'Device
Manager', under Windows NT 4.0 in the 'Control Panel'.
If the software is operated on a computer without GPIB driver, the ES-K1 displays the error message
("Data error - Data GPIB.DLL not found."). This message can be ignored, the software runs in the demo
mode in this case.

1.2.3.6 Starting the Installation

The EMI Application Software ES-K1 has to be installed under Windows. To do this, the first installation
disk is to be inserted in the corresponding drive.

The installation is performed via the taskbar under Windows 95 / 98 / NT4.0 (for Windows NT4.0 / 2000
/ XP administrator access privileges are required for the installation!):

1. Open the Start menu. Select the menu item settings and system control to open the associated
window.

 
2. The dialog is opened by clicking the icon Software and the setup.exe program is automatically

selected from the disk by clicking the Installation key.

 
Note: The installation language is in English. Prior to starting the setup program terminate all

other Windows applications.

When re-installing EMI Software ES-K1 all presettings offered in the queries and dialogs of the
installation program can be accepted with Next or Continue.
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1.2.3.7 Installation Options

After starting the setup program the following is displayed on the screen:

The option Update is used for former versions of the EMI software, which is installed in the system.
The option Demo Installation performs an installation of the ES-K1 specifically for demos.
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1.2.3.7.1 Option Installation

This option allows the installation of EMI Software ES-K1, the supplied drivers and options (by querying
the option disk) and the pre-configured database.

This dialog field selects the directory, in which EMI Software ES-K1 is to be installed. Use the Browse..
key to change the directory or to enter a new directory.

Note: The path name under which the ES-K1 software is to be installed should not exceed a
length of 30 characters.

The setup program then queries the customer-specific option disk:

After inserting the option disk in the cooresponding drive, the setup program offers the drivers and
options for EMI Software ES-K1 via the supplied ID files. All supplied components are usually installed,
confirmation with the Next key is sufficient.

If only specific options are to be installed, selection is via Change.. key from selected components
Program Files, EMI Test Receivers and Acessory Drivers:
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After selecting the corresponding components and clicking the Change... key, another dialog field
allows the specific selection of options by a click:

After selecting the components and options to be installed, the installation of the pre-configured
database for EMI Software ES-K1 is offered.

The option Install Standard Database installs the pre-configured database with the standard data
(scripts, limit-value lines, scan data, transducers, etc.). The option Create New Database is used when
an existing external database is to be imported after the installation.
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If an ES-K1 database is detected, either the existing database is saved in a backup directory before
creating the new database or this step is skipped by selecting the option No Database Installation.

EMI Software ES-K1, the associated Readme files of the installed components and options as well as
the Help files are combined in a program group, which can be selected via the next dialog:
Program group EMI is offered as a default setting:

Before the installation is performed by transferring the files from the installation disks, the setup program
again indicates the selected installation options, the selected components and options, the program path
and the program group for verification:
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The current state of the file transfer to the harddisk is displayed during the subsequent installation
through a progress bar.
At the end of the installation, a re-start of Windows or of the computer (depending on the operating
system) is offered to activate the newly installed driver of the hardlock required to operate the ES-K1:



ES-K1 Introduction

1026.6819.42 1-13 E-8

The ES-K1 program can be started in the selected program group by clicking the R&S icon after
termination of the setup program:

The ES-K1 Readme File contains general and additional current information on EMI Software ES-K1,
which must be taken into account before using the ES-K1 software.

Directory structure of EMI Software ES-K1:

The database of EMI Software ES-K1 is installed in the 'DATA' directory or in
the directories below. All relevant data such as limit lines, transducers, scan
and sweep data, test results, scripts, etc. are stored here.

The directory 'DOC' contains README files for the installed options and more.

The executable program components (binaries, DLLs etc.) are located in the
directory 'EXECUTE' and the referring subdirectories 'DEVICES' and 'ES-K1'.

The supplied databases which are pre-installed by the setup program is
available through a number of directories:

The directory 'I02' holds script examples from the manual for the "script
development kit" ES-K2.

The receiver-specific scan and sweep tables can be imported from
subdirectories of 'Ixx' (refers to receiver option ES-Kxx).

The 'Standard Data' (limit lines, standard scripts, etc.) are located in
subdirectories of 'IMPSTD'.
The meaning of the subdirectories inside (topics) is explained in the
Readme file.

The 'OPTIONS' directory contains the customer-specific authentication files for
the hardlock.

The background pictures for the ES-K1 software are stored in the 'WMF'
directory.
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1.2.3.7.2 Option Update

The installation of the option Update serves for the automatic transfer of customer-specific hardlock key
files of an existing former EMI software installation. This option does not require a specific option disk
since a check for the presence of an ES-K1 software is performed at the beginning of the installation.
If such a version is detected, the drivers and options offered for the installation result from the existing
ID files.

Note: The installation of the new version of EMI Software ES-K1 should always be carried out in
its own directory (without overwriting of an existing version).

Existing data sets can be exported from the old version and imported into the new version of ES-K1.

1.2.3.7.3 Option „Demo Installation“

No customer-specific option disk is required for the installation of the demo mode, all drivers and options
can be selected. This installation of EMI Software ES-K1 is provided for trying out the software in the
demo mode (without active operation via the GPIB interface) or for full operation of ES-K1 with demo
hardlock code 0001.

1.2.3.7.4 De-installation of ES-K1 Software

To de-install EMI Software ES-K1, double-click the Un-Install ES-K1 icon. The de-installation software
clears all subdirectories generated under the installation directory and files, except the database files
created by the user after the installation as well as the file ES-K1.INI in the subdirectory ..\EXECUTE\.
The above-mentioned files or the paths created after the installation are to be manually cleared, as
required.
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1.2.3.8 First Steps after Installation

EMI Software ES-K1 has a password protection for each user, which offers the following advantages:

• The data are protected against unauthorized access

• The configuration of the system can be only changed by authorized persons

In addition, each user of ES-K1 is allocated to a user group. The user groups can be allocated to the
three user classes with different access rights:

• System manager

• Extended

• Standard

User groups or user names are not provided on delivery of the software. Therefore, log-in dialog is not
called when the ES-K1 software is started for the first time, but the user group dialog:

After setting up the user group with the ADD key, the list of users to belong to the defiend group is
entered in the subsequent dialog:
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Note: At least one system manager should be defined since it is only the system manager who
can enter further users in the list of users.

When a user logs in for the first time, the entry and confirmation of the password is required:

After these steps, the installation and the setup of EMI Software ES-K1 is terminated for the user. The
next chapter gives an introduction on how to perform measurements.

Annotation:
When the application window is minimized under Windows NT 4.0, then the window cannot be restored
with the left mouse button, but with the right mouse button instead.

Important Note:
The databases generated by the application are not designed for multi user access, i.e. only one user
may access such a database at a time.
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1.3 Introduction to Operation

In the example below, interactive control of the software is explained step by step to familiarize the user
with the logical sequence of operations.

The example is based on a specific measurement task that can be performed immediately with the
equipment shown. For practising, the measurement can also be performed without the said equipment
in the virtual operating mode. This mode is automatically selected if there is no hardlock at the printer
output of the computer. In this case, the "Test Setup" and "Block Diagram" sections are irrelevant, and
the values entered into the test report are simulated values supplied by an internal random generator.

1.3.1 Measurement Task (Example)

Measurement of EMI voltage on the power line of a domestic appliance with 200 W power
consumption; continuous interference, pure broadband interference, ie without internal processor or the
like.

Test setup to CISPR 16-2, Figure 2.

Limit values to EN 55014

1.3.1.1 Test Setup
> 200

>80

80

30..40

40

wooden
table

DUT test receiver

groundplane

LISN

u-cond-3

FIG 1: Test setup to CISPR 16-2
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1.3.1.2 Block Diagram

EUT LP filter

EMI test receiver

mains
power supply

RFI

RFI RFI

HP filter

LISN
PC with ES-K1line selection

TTL GPIB

FIG 2: Block diagram of EMI test setup

1.3.1.3 Definition of Terms

Some terms necessary for understanding ES-K1 operation are explained below.

Transducers are four-terminal networks connected between the input of the test setup and the test
receiver, for example a test antenna in EMI field strength measurements. The antenna converts in a
defined manner the EMI field strength level (given in dB(µV/m) for electrical field strength) into a voltage
level (measured in dB(µV)), which is displayed by the test receiver. The difference between the two
numerical values is referred to as transducer factor (unit: dB(1/m)), which is usually frequency-
dependent. Stored transducer data, therefore, always include the transducer factor and the conversion
into the correct unit so that the result displayed has the correct magnitude and unit.

Standards, which are listed in the ES-K1 database, contain information on emission limit values, the
frequency range to which a given standard applies and on the setup of the test receiver. All of the
standards in question cover product families. For example, the EN55014 standard applies to "Electrical
equipment and systems" covering, among other equipment, all domestic appliances and electric tools.

Scanning is the tuning of the test receiver step by step across a given frequency range. For this, the
step size (absolute or as percentage of the tuning frequency), the dwell time for each frequency, and the
start and stop frequencies are to be defined. Synthesized test receivers (eg ESxS, ESS, ESPC) are
typically tuned by scanning.

Sweeping is the continuous tuning of a test receiver across a given frequency range. In addition to start
and stop frequencies, the time for the receiver to sweep the frequency range is to be defined. This
tuning mode is typically employed by spectrum analyzers, although some analyzers can be tuned step
by step as well (eg ESMI). Series ESxS and ESS test receivers have no sweep capability. No sweep
tables are therefore supplied for these units.
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1.3.2  Starting ES-K1 Software

Activate ES-K1 icon
in Windows Program
Manager field.

FIG 3: ES-K1
software icon

When program has been loaded,
enter user name and password (log-in):

 
FIG 4: Log-in dialog window

NOTE: The user name and password must be entered in exactly the same notation (upper-case
and lower-case letters) as in program installation. Even the slightest difference will result in
abortion of the program. It is therefore advisable to note down the user name and password
before entering them during program installation.

Confirm user name with TAB key (not with
RETURN!), and password with OK or RETURN.

The response message depends on whether or not
a hardlock is installed at the printer output. For
practising, the program can be run without
hardlock. In this case, the window (FIG 5) shown
opposite will appear: FIG 5

On confirmation with OK, the default background mask of ES-K1 Software (FIG 6) appears, from which
operation of the program can be started.

FIG 6: Background mask for Software ES-K1
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1.3.3 Programming a Measurement with ES-K1 Software

As an initial step, configuration of the test equipment as shown in the test setup (FIG 2) is to be defined.
For this, select Device Configuration... from the Options menu.

FIG 7 Device configuration dialog window

Instruments addressed by ES-K1 can be loaded into the Device field.

On clicking on , available devices appear after approx. 10 s in the Device field from where they
can be selected by means of the scrollbar. In this example, Test Receiver ESHS is selected. Then the
Interface (Õ GBIB0), Address (Õ17) and Mode are to be set. The virtual or physical mode is selected
automatically depending on whether a hardlock is installed or the measurement is performed with real
devices, see 1.3). Devices can be switched passive (Active not selected). This prevents measurement
errors in the case of devices listed but not connected.

Entries in the Name field are optional. They describe a device more precisely if several devices of the
same type are used. Entries in the Description field are optional, too.

On clicking on , ESHS is transferred as the first device to position <End of table>, which thus
moves one line down, ie <End of table> is always indicated at the end of the list.

Next, Two-Line V-Network ESH3-Z5 is to be selected in the Device field. ESH3-Z5 has no GPIB
interface but is driven via the parallel TTL interface of the test receiver (see FIG 2), so the GPIB address
of the test receiver is to be entered, ie the default address 20 is to be changed to 17. Then Two-Line
V-Network ESH3-Z5 is to be transferred to the device table by clicking on Insert. FIG 8 shows the
complete device configuration. Any entries made in the Name and Description fields are displayed in
the corresponding columns of the device table.

Make sure to confirm the settings made in the Device Configuration window with , otherwise
the settings will be lost. Note: if there is no response on clicking on OK, click on Modify even if no
modifications were made, then OK will be active in any case.
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FIG 8:  Completed device configuration. Return to main menu with .
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1.3.4 Preparatory Operations for Measurement

The shortest way of parameterizing the devices used is by calling the data stored in the database of the
software, ie tuning mode of test receiver (scan or sweep), transducer characteristics (eg of artificial
mains networks) and limit values stipulated by standards. The ES-K1 database is managed by the
Navigator, which is called from the File menu (FIG 10).

For initial use of the ES-K1 software, information first has to be loaded into the database and is then
available for any subsequent measurements.

Software handling is therefore different after initial installation and subsequent operations.

After installation, the Scan Table for the receiver used must be loaded. To load the table, first call the
Navigator (Backup Database) from the File menu.

FIG 9

The Browse key (FIG 9) activates the Path dialog window with the import directory (see README files)
from which a subdirectory with the scan tables for the receiver used is selected.

FIG 10: Subdirectory K10/EHS with scan tables for Receiver EHS

Then the required scan tables designated with the name of the standard are marked and transferred to
the scan table under Navigator... by means of Execute.

The standard import database is stored in the same directory in which the ES-K1 Software was
installed. The scan and sweep tables can be selected from the subdirectories for the receiver versions
(K10, K11, etc).
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1.3.4.1 Performing the Measurement

When preparatory operations as described under 1.3.4 are completed (required only after installation,
not for recall of ES-K1 Software), the measurement task as defined in chapter 1.3.1 is performed
through the following steps:

Call Navigator from the File menu. In the Navigator window (FIG 11), click on Open under Function
and select Scan Table under File Type. Under File Name, select EN55014 Voltage and click on OK.
The Scan Editor window (FIG 13) will appear.

FIG 11: Navigator database manager selected from File menu. Selection of Open function and
Scan Table file type. Calling of EN55014 Voltage file.

The Scan Editor window usually already contains data from previous settings. What the operator has to
do is to edit the data to make the required settings for each subrange. The Subranges list box (upper
right in FIG 16) is of primary importance. The list box will however be empty after installation of the
software. In this case, proceed as described under 1.1.4.2.

It is important to note that for each subrange selected from the Subranges list box the settings in the
Subrange window below are made separately, while the settings made under Unit, Detector and Mode
above apply jointly to all subranges. It is therefore advisable to assign one of the four possible detectors
(MaxPeak, Average, QuasiPeak and RMS, selectable under Detector) to each of the four curves
(Curve 1 to 4). Desired detectors for the individual subranges can then be selected from the Control
window below the Subrange window.

Select the desired subrange from the Subranges list box by means of a double click . The associated
settings will be displayed in the Subrange window.
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1.3.4.2 Editing Data in Scan Editor Window

1.3.4.2.1 Adding a Receiver

By clicking on Receiver in the Subrange window, all receivers entered in the Device Configuration
table can be called. The selected receiver is shown with the settings stored in previous measurements
displayed in the various windows under Subrange. Make the required settings including
Attenuation/Gain, Transducer, Curve 1 to 4 and Demodulation. Conclude settings with Subrange
Check. Click on Insert (upper right). In doing so, make sure that the blue selection line in the
Subranges list box indicates a frequency range higher than the subrange to be added. Otherwise an
error message will be output. Store setting with OK.

1.3.4.2.2 Changing a Frequency Range

Select frequency range from Subranges list box with blue selection line. Double-click on frequency
range to activate it. All associated settings will appear in the Subrange window. Change range as
required and conclude setting with Subrange Check. If the new value does not match existing settings
(eg artificial mains network above 30 MHz), the operator is prompted to make an appropriate correction.
Click on Modify to confirm the change. Store with OK.
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1.3.4.2.3 Deleting a Frequency Range

Select frequency range from Subranges list box with blue selection line. Activate range by means of
single click. Then click on Delete and store with OK.

FIG 12: Scan Editor - EN55014 Voltage

FIG 13: Scan Editor - EN55014 Voltage, after double-click on test receiver marked blue in
Subranges list box and calling of transducer ESH3-Z5; confirmation with Insert in the
upper right. Curve 4 (rms detector in this case) is not available for ESHS.

It should be noted that MaxPeak in conjunction with 10 ms measurement time will provide a coarse
result for orientation only. For measurements in line with standards, the quasi-peak detector would have
to be selected for curve 1, as well as a measurement time of 1 s. However, this would lead to
uneconomical measurement times, so a time-saving approach (subrange analysis) is usually taken for
this type of measurement.

The DUT in this measurement task is a pure broadband interferer. This means that it does not cause
sinusoidal interference on just a single frequency. In this special case, it is not obligatory to measure at
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each single frequency of the range but the range can be scanned in steps larger than the bandwidth of
the test receiver. It is appropriate to select logarithmic steps. With a step size of 12.5%, total
measurement time at each frequency will in this case be just about 1 min 40 s even for the standard-
conforming measurement time of 1 s.

 Logarithmic scanning in 10 % steps

FIG 14: Selection of logarithmic scanning. It should be noted that the step size actually selectable
depends on the receiver characteristics. Type ESxS and ESPC receivers allow for step
sizes with a factor of 100%/2n only, ie 100%, 50%, 25%, 12.5%, etc. The nearest possible
step size is set and displayed in the Step Size window after clicking on Insert. In this case,
this is 12.5%.
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1.3.5 Measurement

1.3.5.1 Example of Virtual Measurement

The measurement described in this section is based on the settings made in the previous sections 1.3.3
and 1.3.4. In this case, however, no hardlock is installed (virtual measurement). Results (FIG 18) are
supplied by an internal function generator (simulated by the software). The measurement described is
therefore suitable for demonstration.

Select Test from the menu line of the initial mask. From the Test menu, select Measurement and then
Scan (FIG 19):

FIG 15  Calling Measurement and then Scan from the Test menu

Click on Scan. The scan settings made before are displayed (FIG 20).

FIG 16 Scan settings. Note: No rms measurement will be performed because Curve 4 (rms
detector) cannot be selected in the Scan Editor since Receiver ESHS contains no rms
detector. Despite this, Result 4 (rms value) is included in the Scan Settings because it is
possible that a subrange not used here is used by an ESS (with rms detector), and the
scan table applies to all subranges.
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The measurement is activated by clicking on Start.

The graphics shown in FIG 18 is displayed while the measurement is being performed. The icons
numbered 1 to 8 for the various curve configurations can be assigned as required to the two test curves
(QP (quasi-peak) and AV (average)) and to the limit lines from the database.

QP limit line to
EN 55014

AV limit line to
EN 55014

AV test result

QP test results

Max peak test results

FIG 17: Display of results

Marker

Autoscale Y

Autoscale X

Grid configuration

Trace editors (max. 8 traces)

Delta marker

FIG 18: The line of icons above the chart is used for configuring the chart with the test curves as
required. Particularly helpful is the zoom function, which is always active and operated with
the lefthand mouse key. The icon is for returning to the unzoomed chart.
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1.3.5.2 Practical Measurements

1.3.5.2.1 Measurement of Broadband Interferer in Range 150 kHz to 30 MHz

FIG 19: Scan Editor. Note that curve 4 is switched off in this case too because ESHS contains no
rms detector.
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FIG 20: Display of results. Left: using graticule stored in previous measurement with frequency axis

from 9 kHz to 30 MHz. Right: after clicking on "Autoscale X" icon . ESHS test
sequence: QP and AV values determined in first run, MaxPeak in second run.
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1.3.5.2.2 Measurement of Broadband Interferer in Range 9 kHz to 30 MHz

FIG 21: Note: 149 kHz is the highest frequency selectable for CISPR band A (9 kHz to 150 kHz) in
conjunction with a bandwidth of 200 Hz and QP display. The program will not accept the
value 150 kHz for CISPR band A with QP and 200 Hz bandwidth.
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FIG 22: Display of results. Left: in default diagram. Right: in diagram with level range adjusted as

required by clicking on Autoscale Y icon .

From the above figure it can be seen that the legend for the curves is printed completely on the
hardcopy. On the screen, there is only one line displayed at a time; the lines for the other curves can be
displayed by scrolling.


